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1: Installation - User ID registration

To use Frames, you will need to install software.

*Please refer to the details for the recommended environment (= P28)

Operating Procedure

Run Misumi_Frames_setup_dl.exe
*Administrative privileges may be required.

.CF; MiSUMIi_Frames_setup_dl.exe
v

Proceed with the installation according to the screen.

-Attention.

If you are not up-to-date with Windows Update,

you may not be able to install the software correctly.
Please do so while connected to the Internet.

You will need to download the necessary files during
installation.

» Do not execute any files other than the installer during
installation. It may not be installed correctly.
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2: Screen configuration

Header menu
Camera Control
There are File, Tool, Help, Intermediate File Output, .
Drawing Creation, and Parts List Output/Quotation Area used for camera operations
menus. such as viewpoint changes and
movement.
- - View Control
Parts Selection 7 V1N .7+ Change the viewpoint with
: Frr— 17 selected surface.
List -
=oL 5 Pan
You can check and o oot [ H— i Switches the camera to
change the products £ / move mode
you have pl_aced. You Rotate
can also adJUSt the — = « f:“' Switch the camera to
display size of the S — = . ° “ rotate mode
frame. & dcvsoq b 3 A &)
" Surpencion Purts g - . f" 200m
= o ﬂ Switch the camera to
1] o : = N zoom mode
Insert Menu 5 r.- Screen Fit
= | — "" 2 All drawing objects fit
Select and insert a - e Displayed to scale.
template or component \
from the list. - "{,;}" Change view
Model nl_meer search is L=4  Dimensioning/fastening
The display will be shown.
Part Edit Tool .
Guide shape
Used when editing a selected part. @ Use for Display and
It is displayed when a placed part is selected, and the display location gfg'r%slﬁ::y Guide data
can be moved to a right-clicked point.
Configuration
EII Default Part, Mouse Operation,
Shortcut Key, etc. 5
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3: Mouse operation

In FRAMES, the design is displayed on the 3D
screen.

Firstly, please check basic viewpoint operations
on the 3D screen.

Operating Procedure

- Hint -.

Mouse operation settings car_l__m_be changed.

[T T —————

[How to check/setup]

Click on "File" menu in the upper ~

left corner of the screen
—Select Configuration.
—Select Mouse Operation.

Basic screen (/”f‘\l Move the viewpoint by dragging
e.g: Frames standard \__J the mouse scroll wheel.
e o T T ] RS e R

during drawing anytime.

[T S T

8 mouse operation patterns are available.
Please select according to your preference.

1 |Frames Standard

2 | SOLIDWORKS like

3 | CATIA like

4 | NX (NX9 or later) like

2™ Zoom in/out of the camera 5 | NX (NX1 later) lik
@1 Rotate the camera by @ by using the mouse scroll (NX10 or later) like
: . .
o ot o __wheel up and down. 6 |iCAD like
R : e e =y ey
o= S="® 7 | Creo (Pre Pro/E) like

8 | Inventor like

© 2022 MISUMI Corporation, All Rights Reserved.



4 : Configuration

- Hint -.

Settings can be changed in Configuration menu.

You can change mouse operation to suit your CAD system

or set the default settings for frequently used components. Youlcan open e settings screen

from the camera control area. =

The default settings for the most frequently used parts
will make it easier to use.

Operating Procedure

(1) Display Configuration (2) Change settings

Select “File” menu in the upper <Item Summary>

left corner of the screen . T -
— Configuration Set the area size, grid width, projection method and

— Select each item General other settings related to the screen display at the time
S of drawing and set the tutorial to be displayed again.

FRAMES o et
Set the mouse operation assignments for camera

Mouse operation .
control operations.

Set shortcut key assignments for operations such as

Shortcut key saving files.

Set the parts that are inserted by default and the
Default Part fastening method for panels that are inserted
automatically.

' Release notes You can check release notes information.

o About MiSUMi Frames Yoq can checll< notlces. of campaign information and
— maintenance information.

Help You can check links to various types of support.
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Basic operation
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1: Aluminum Frame Insertion [Basic operation]

Select Aluminum Frame and easily insert on
the screen by selecting and clicking on start
and end points.

Brackets and other fastening parts are also
automatic placement.

Operating Procedure

(1) Aluminum Frame Selection (2) Placement

Select Frame from
"Aluminum Frame" in
Insert menu.

FRAMES o e

Click starting point

P I R

v
v Click again at the end point
T i e e
: |dw v @ =
v 8 E

Click start and end points,
then click place Aluminum Frame

/ placed!

Tab [
\ P
L= i

- Hint -.
The placement of products is supported by 3 different color
displays.

(1) Blue (2) Orange (3) Red
Correctly fastened part Locations to be adsorbed in Error location
alignment
— ::;‘,%-.""-
R N\ /‘
“‘2,%
N - 2=

(3) Completion
Click "Finish" button to
exit placement mode

| YN

==

For the fastening part
.~ Brackets automatically You can specify length
dimension of Aluminum
Frame, by pressing "Tab"
key on your keyboard
and manually inputting

desired length value.

/// \.‘- =
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2: Fastening parts Insertion [Basic operation]

- Hint -.

Bracket/Corner Bracket/Blind Bracket/ Inserted joints, etc. can be confirmed in the "Display fastening parts"
Joint/Sheet Metal, etc. are available. in the camera control tool.
When clicked, the fastening parts are T
Nut can be inserted by itself. Highlighted and Other parts are transparent /;
Operating Procedure =
(1) Select Fastening parts (2) Placement
Select the product from Insert menu When mouse cursor close to Aluminum frame, it will be absorbed in the position

where it can be inserted, so click at the position where you would like to place it.

. *Brackets can only be placed where they are connected to 2 Aluminum frames.
Example: Bracket selection screen

Click on a placeable
location to place it.

Example: Nut selection screen For other parts can be

placed by using mouse. The length of Aluminum

Frame is automatically

PTAMES v e

—_— shortened by the Corner
e Brackets placed.
: Double fastening is
. & & possible by using
reinforcement frame

brackets.
© 2022 MISUMI Corporation, All Rights Reserved.



3: Panel insertion [Basic operation]

- Hint -.

You can change the fastening method from the change panel screen.
In FRAMES,

. Possible Fastening Methods] s :
Easy to Insert Panel [- Bracket fasteningg : e =] = ) B

- Panel Clamp Fastening
- Aluminum Frame Fastening
- Door frame fastening .

5 Tt gt o o vt T
et b et

- Sliding door frame fastening B
Operating Procedure -
(1) Panel selection (2) Placement
Select Panel from Insert menu Click on surface to place Panel
L a e =

$ Panels can also be inserted onto
s end surface of Aluminum Frame.

(Bolts are placed avoiding the
end surfaces.)

= oEs =
In placement mode, can click &
"Change insert product" button to sy
change panel clearance or
thickness or select bolts, nut, Once panel is in place, the additional machining on
brackets, etc. fastening parts and placement of necessary parts are
also available.

This is done automatically and reflected in the BOM. 9
© 2022 MISUMI Corporation, All Rights Reserved.



4: Door creation function - easy setup [Basic operation]

_ | | - Hint -.
With FRAMES, you can quickly design door
by simply selecting the minimum necessary parts. You can select how to insert door unit

Insert as an door assembly — you can edit on this function
after insertion.

Inserted as an each parts — you cannot edit the door with this
function again.

No need to set Clearance.

You can select the type of door; One hand door, Double door,
Folding door, Panel door, and Panel double door

Please select according to your application

Operating Procedure

(1) Select surface to insert the door (2) Select the type of door (3) Selection of essential parts

Select products such as Aluminum frames, Hinges,

Select "Create new" from Door in Insert The door creation screen is launched. !
menu, then select surface which the door First, select the door type. Handle, Frame Cap. The selected products will be
will be placed. placed automatically.

um...DOOr " FRAMES e vams o

[t o o |
FRAMES . s

.

EEEE L E

- == s

Panel door design
is also possible.

(O Paneldoor (O Panel double door

V Please select the door opening direction

st Fitnsy ) e

Check the automatically created door
and if there are no problems,

click "Insert". It will be placed as is in
the 3D screen.

*If you would like to edit it further
See in Detailed Settings in (= Advanced Operations, P.23) 10
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5: Accessory parts insertion [Basic operation]

- Hint -.
Various accessory parts for design such as

Frame cap/Slot cover/Handle/Hinge/Magnetic catches, iz @(ee €l 52 et lisal by
etc. are available recessing cap thickness.

[How to change]
It can be selected and arranged from the screen When placing Frame caps, tick in

. a box 4 Insert by depressing the cap

Operating Procedure ~

(1) Accessory Parts Selection (2) Placement

Intuitive product placement is possible according to various
placement methods.

Click on "Accessory Parts" from Insert menu,
then select a desired product.

Triangular pyramid mark

will be shown on
_ possible placement
@n‘ locations.

Example: Frame cap selection screen
:ﬁ ‘ Click on Triangular
/ / pyramid mark to place
Frame cap.

Or click again to remove
Frame cap.

Boeg &

a Click to place Handle
where available for
Ll = placement.

11
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6: Part editing (move/stretch/rotate/information view/copy/delete)

With FRAMES, the model number
automatically follows as you edit the product.

No troublesome model number management
or modification work is required.

Operating Procedure

(1) Change the range of products by using mouse

; 'f' Mowve
:‘ .r, Expand
. 1) Rotate
(2) Select a function from|| .
. i Copy
Part Edit Tool menu. % Change Product
Change Product
e sig s o Alteration
o Property
B Delete

After specifying the placement direction
Placement by mouse operation

SRAMES e it
Various shortcut keys are : | I ) BT
also available for set up. B [== o
[How to check/setup] S
Click on "File" menu in the & =
upper left corner of the screen | =~ -
— Select Configuration ol |
— Select Shortcut Key N — =
LI
J

[Basic operation]

Movement

After specifying the direction of
expansion and contraction
Expansion and contraction by
mouse operation

(Full length and differential can
be selected)

After specifying the
direction of movement
Move by mouse operation

Copy and Place

Product Information Details

After specifying the direction of rotation
Rotate by mouse operation

Deletion

Selected Product Information
Screen activated

© 2022 MISUMI Corporation, All Rights Reserved.

Delete selected parts
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7 Product change

Easy to change the placed products
whether single item or multiple items.

Operating Procedure

(1) Click on "Change Product
After selecting the product,

click "Change Product" in the Part Edit Tool box.

[ e e

(1]

"P Maove
o * Expand
4D Rotate

_& Alteration

0 Property
W Delete

fﬁ Copy
M

[Basic operation]

- Hintm;.

[ e

You can change multiple products
at once If they are the same
products.

After selecting a product, click on
"Collective change" button on
the products list screen. 2
Then, selecting the desired product, 9\\
and click "Apply". Z

Y
(2) Select products
Select the product you would like to change, and the product selection screen
will appear. After selecting the desired product, click "Apply".
Example: If you would like to change the bracket
S — Bracket Selection Screen
*Items that cannot be changed are
displayed in red.
Change Complete

13
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8: 2D drawing output

The design project is easily output to a 2D drawing.

You can select Dimensional drawings, Assembly drawings,

Assembly development drawings, Panel drawings, or

- Hint -.

2D Drawing can be printed ?l
or exported in DXF file format.

=

=
[ ]

Dim. Annotatioff Export/Print v

[Basic operation]

Fra me dranngS. [OUtpLIt MethOd] : o:n HFsa-:ru‘at)‘-d:z\(JEr Aluminum FrameESer!esf.slmwa!:th ?:,;Dmm.
Click Export/Print on R S o, P
2D Drawing screen e e
R T T T
Operating Procedure <
(1) Drawing selection (2) Drawing creation
For Drawing output, The specified drawing will be created.
Click "Drawing" button from Header menu. *It takes some time to create drawing for the first time.
Then, select Drawing type that would like to output Dimensions (Outline) Assembly Panel
PR o @ R sinesiars = = T = =\ == L
3 = X .
|
Frame
P = You can switch to other = = =
drawings type by clicking T . .
) utine ) "Outline" from Header menu.
S Select
L. Drawing type
[ Frane 5 == = o E:J —]
[] #Fsa-2020-240 [1-7]
Cli¥esamanty Drawing pages can be added by clicking on ﬂ button on the right side of
] ese-a0a0-240 -3 ) the screen.You can also switch pages by clicking on the numbers.

14
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9: Drawing edit (explanation of each edit button)

You can edit Drawing by moving, changing scale or
add Balloons, Dimensions, Annotations, etc.

When creating a 3-view plan,

select the plane

and scale can be changed.

Sectional views or Isometric Drawings can be also added.
Follow the selections on the

screen, then create and edit.

[Basic operation]

| Change Front
Disp
[ =

front selection

«=Scale Selection

Operating Procedure

After the Drawing is created, click on each edit function to edit the item.

Drawing Edit Screen

Bill of Materials Editing
Change display items

d = F|[B ® EEJ”@.;;'.EI
BOM Frame Iiew Section¥  lsometric]] Balloon Dim. Annotation

Figure Frame Editing
DXF import is also available

Section view
View sectional 3D drawing

3 View Selection

e Specify the view to display
O CEFE |

© 2022 MISUMI Corporation, All Rights Reserved.

Isometric view

Balloons, Dimensions and
Annotations

You can edit by clicking button
from Header menu.

Example: Edit dimensions

>

You can click "Change layout" button

Can change side view and scale | from bottom right corner of the screen

for editing Drawing size.

15



10: BOM check/edit and BOM output [Basic operation]

Display bill of materials for the design project.

Operating Procedure

View/Edit Bill of Materials

You can click "BOM, estimate" button from Header menu,
for viewing part list.

—
= —— I

- P ] e, | v el M

| l.' | I = .I:

o | e . . Ear

16
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11: Default part settings [Basic operation]

- Hint -.

In Frames, you can set Default Part from e -

configuration and it can be automatically inserted. You can set Default Part

_ _ _ from Insert menu. :
Please modify to suit your design. o [T

B rarct

i Frame Cap

Operating Procedure ~

(1) Select "Configuration (2) Select "Default Part Default part change

from “File” menu Detaut Part
in the upper left corner. The following products can be set.  auminnsouson
Configuration g Default aluminum extrusion HF$6-3020 Search
o - Aluminum Frame E3
ES for Thaitand oo - Panel Fanel
| Fl| ool Help - _ Frame Cap Default panel ACA
Panel fastening method Bracket fastening (]
Create new

Mouse Operation
Frame Cap

Default Frame Cap HFC6-3030-B

Open the project

Open the backup file

Shortcut Key
L
& Owverwrite and save the project
e Default Part P Automatic Fastening part change
Save as a template Fastening parts
) Release Note You can set parts that will be automatically fastened | @) metnod of setting the fastener parts
v e siife when placing Aluminum Frame.
N . Series 5 3 ( 1)
Temok : Please set it for each frame size.
emplate setting
About MiSUMi Frames . . Number of Slot 1 v
Configuration ® Select Aluminum Frame Series, Number of Slots
and angles that you would like to set. Number of angles 20 v
Terminae Notifications @ You can set fastening parts for each placement
x method, and it will be saved. Perpendicular placement HBLFSNS Search
" 45 degree placement - Search
A Help greep (2)
Linked placement - Search
Parallel placement - Search
Cross placement HBLFSN5 Search
Balt and nut set SET{Screws & Nuts Set) w

17
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Advanced operation
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1: Intermediate file output

With Frames, the design project can be

output in Intermediate file format.

Operating Procedure

(1) Export

Click on "Intermediate File Output" in the
Header menu

sl — @m
: . [** Intermediate file output

w

B v @ & T

After selecting Output destination and
File format, click "Export" button.
An intermediate file will be created.

----- AL e = —
\ 4
If the conversion takes time,
ek s An estimate creation time
is displayed.
If there are is no problem,
select OK.

[Advanced operation]

- Hint -.

Conversion and Merge tolerance =
of intermediate file can be adjusted. = e

*Default setting is recommended.

2) Operation with CAD

Please import the data into your CAD system

-About the specifications
m Recommended Environment
- Same as Frames operating environment

(Excerpts from main recommended environments) - jCAD V7L5
- OS :Windows 10 64bit -NX 11

m Recommended CAD
- SolidWorks 2016/2017

Windows 11 64bit
(edition: Professional , Enterprise)
- Graphics board : Quadro (NVIDIA)

- Inventor 2018

®m Output Format
- STEP format (AP214)

FRAMES is not guaranteed to be used in virtual - Parasolid format (V9.0)

environments such as Hyper-V and
VMWare. Please install the software on actual device.

*STEP format is recommended.

© 2022 MISUMI Corporation, All Rights Reserved.
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2. Template Core Equipment Insertion

In Frames
You can insert templates and core equipment models.

Templates allow you to create your own frequently used
by saving the shape as "My Units”.

[Advanced operation]

- Hint-.

It is also possible to create simple shapes
without loading core equipment data.

After clicking "Insert Simple Shape"
from header menu, input dimensions.

......

Speny

Operating
Procedure
3D Drawing screen
— (1) Template insertion
FRAM

Measure frame strength

alculate the total mass

D).

% | I Insert STL data
(] - . D
Insert simple shape ozssobpratrg | oo
‘(D Insert guide shape ‘ [;-li] [g]
st A25aerelas bl tod Hicuos
ORI e | 28008 Wasteeyee
Salas! [ EV S | [ﬁj m

(2) Core equipment data insertion

Click “Insert STL Data” from
Header menu to import STL format >
data and shape format.

If imported core equipment
overlap with other part,
it will be displayed in red.

In "Template" in the Insert menu
Standard Units" or My Units. - Ente
Click to select the shape.

......

G 0t

Save My Unit

Select “Save as a template” button
From File menu and click
“Save destination settings”.

v

Input Template name and
select saved destination.

*For save destination, go to
"Group to save to" field,

You can create a new one by
directly input name.

With dimensions reflected.

........

orporation, All Rights Reserved.

r dimensions for placement P> The unit will be placed.

20



3: Guide Shape Function - Function Description

In FRAMES, you can create a rectangle guide - Hint -.

[Advanced operation]

Shape based on STL data such as eqUipment/ Guide shape can be displayed/hided at anytime.

and place Aluminum Frame along the guide
[How to display/hide]

v Disgley guids data

v Display grid line

Shape' Click "Guide shape" on the right side of screen Q.
Display guide data:.

Use for designing equipment covers and other szg;fzrfi%r|ﬁ,'2play o e

equipment. — Click for Display or Hide

Operating Procedure

- Image of design using guide shape-

Load core equipment Create guide shape Create Aluminum Frame accordingly
/Outside stick Inside stick
~ f
| >
Dz
v

Places Aluminum frames along the created guide shape

STL format file can be read. o Create a rectangle guide shape
from core equipment Can be placed inside or outside
You can check interference e Can be created by setting
and create a guide in this function.  clearance with core equipment *Qutside stick: Convenient when placing equipment inside

Inside stick: Convenient when equipment is installed outside

© 2022 MISUMI Corporation, All Rights Reserved.

Completion image

Y

Matching equipment
Size Structure is complete!
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4: Guide Shape Function - Operation Flow

Guide shape can be set not only from equipment data,
but also possible to set numerical value.

Stick guide shape method and Grid can be also set.

Please use it according to your own design method.

Operating Procedure

(1) From “Tools" in Header menu
Click on "Insert guide shape

MisuMi
for Thailand

ool JHelp =

Measure frame strength

e

Calculate the total mass

»
"

5

Insert STL data

A ’r:ser': simpie shape

| Insert guide shape I

& O

-Example of customization

[Setting details]
e Size
— Slightly wider and thinner than
equipment
e With/without grid

— Only the center line is displayed.

e Stick position
— Qutside stick

(2) Select Stick position

Measure I

Stick postian

e
fﬂ
® Suck inside of section

*For differences in stick position

L Stick outsice of section

Careet

see previous page

Base plate instead!

- H

The created guide shape is saved in the project together with the designed structure.
It can be viewed as indicator at any time, unless deleted

[Save method]

Save the project as usual *It will be saved automatically.

[Advanced operation]

int -.

(3) Select the creation
method

Gude shapa

e Create with a rectangular guide shape
by inputting size

e Load core equipment and

create guide shape on equipment data

[Setting details]
o Size
— Size of building with one person's
space left empty.
e With/without grid
— Without
e Stick position
— Inside stick

© 2022 MISUMI Corporation, All Rights Reserved.

(4) Make various settings
(please customize according to
your own design method)

Configuration setting
e Size

— can be expand or reduce size
after placement
¢ Placement position

— can be moved after placement
e With/without grid

— can be selected with or without
grid
e Stick position

— can be selected outside or
inside stick position

As an indicator of
equipment placement
restrictions!

O .
=

22



5: Door creation function

You can make detailed customization

to the door you create.

Operating Procedure

(1) Click on "Detailed" button on
Door - Easy setting screen.

Dioor - Easy setting

HEDEDEDEHEELE

Mai oor settng b compiee, ComfnT te donr specrations ani
et s, It you i In dete] chicke da "Detais” BLston

Doar lype: e hard dace
Doar open directon; —
fooe | pm | Ao | Cmees |
Denemuon{¥l mm
DémensicrZy 255 mm

Aluminum Extruzions  HFS5-2000

Fasterirg Parts: HBLTSS

Bear:

DoonX/Zx = MNone ¥-fine K-fire

Longer frame w Xina  Vhee
e | [ |
o

*Even you are in Easy setting,
you can click "Details" button for more
detailed setting.

Door - Eidy detting
CDEDERLEBEDED D L]
Selact the Frame Cap part number.

| Na & L]

- detailed settings

[Advanced operation]

Hint -

Save the door settings once created and the next time you create a door.
It is possible to call up.

[How to save]

On the confirmation screen before door insertion,
Select "Save this setting”

[Call up method]
When creating a door, select "Load the door file"

Various editing is possible, such as changing/adding/deleting parts, changing size/clearance, etc.
Frame size

E@hq ngelfrla me-
=LYPe

P o Eagpseting
e R Cearmee |
Cimensian(}s 256 m
Dimensian(Zy 255 mm
Alyminum Extrusion:  HPS5-2020
Fastering Parts: HELTSS
@ Editin 30 iew

Beam:

Dooe(XiTe @ None 1 ¥eline ) Kolme
Langer fame: @ XEne (0 ¥iine

e puarts W et g e et

Panel Change Accessories parts

Clearance change

[ s EE
D - Detad setting Dioat - Datail setting Do - Dxtal etiing

Doce type: One hand door Cre hand doar Door type:
Dioor open dimetion: — Eazy attng

s N i = _ Esymmed ||| Doce open drection: e heind e | Eoyomeg |
frame =0 Arremores | Cewre e o Frame Fane | boessores nos
Pacel numben  # Common use ) Clatamize Hinget Tepe E| mim
Top [8E8 & HHESNG. - Botorm: [2 mm
Bact |Na fh] HHPSHS & Hinge T mm
Hanalg* DOpers L4 mm
UPCN19-8-36 oY
Slide Lock:
Ha =
Magrea Cateh
he ]
Frame Cap*; #® Comman use ) Custh
Lt =
St Casr % Commanuse (3 G

When settings are changed on the various
screens, the changes are reflected.

Parts can be moved and deleted directly on the 3D screen.
If you want to change a part, please change it within the tab

screen.
o | e | seswe | Cemene |
Hirsge*:
[ HEPSNS @
b ] T
HESHS = | Mave parts
Handle*: ) B

© 2022 MISUMI Corporation, All Rights Reserved.
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/. Suspension parts insertion [Advanced operation]

- Hint -.

Plate/Caster/Foot Base/ _ |
. . Adjuster pads are designed to prevent the floor from = =
AdJ u Ste r pa d S are aval |a b | e. Height adjustment (0.5mm increments) : il

[How to change]
Select the adjuster pad and click "Change Product"
then, input value in "Adjustment pad Insertion position”

After selecting the product, insert it into fold
Aluminum Frame. —

Operating Procedure

(1) Select Suspension parts (2) Select combination parts

After select plate, "change suspension part" screen will be
displayed.

Click on part number of suspension parts to open the
product selection screen.

Click "Suspension parts" button from Insert
menu, then select a product

Example: Plate selection screen — s ; —;_3 —z —i Example.)
— w C— . % %_  Insert from
o I T i N el T

(3) Placement on Aluminum frame B

o ) o ] Move the mouse cursor close to Aluminum frame,
*When placing it on the bottom side, it will be easier to caster will stick to the placable position, so click ~
insert it if you look up from the bottom of the design. on the position you would like to place it. ,
>
You can continue placing products until you click
"Done" button.

*When placing it on the bottom side, it will be easier
. . to insert it if you look up from the bottom of the 4
© 2022 MISUMI Corporation, All Rights Reserved. design.



8: Manual add-on function - Flow of operation [Advanced operation]

Fram.es a”OWS YOU tO manua”y add alteratlons fOI" Additional machining (alteration) can also be edited = -:;L
Aluminum Frame and Bracket. on "Change Product” screen or Edit menu B

after selecting a product.
Please use it for designing holes for mounting = % S
various parts. & ol

Operating Procedure .

(1) Select product for proceed alteration. (2) Select the alterations (3) Specify the position and direction of processing
Click on "Alteration” button form Insert men, A_Ilst of _addltlonal operations that can be added Follow the displayeq guide to specify alteration position, direction,
. will be displayed. and type of machining.
and then select part number to alteration.

Select the type you wish to add.

FTR— . Fixed position Specified position and direction
Piegse smlact the sltmrtions. oo et tus o tomiee
’ et s
X Aad ppncs on Trame enck. e

ol |F ek wrench aceess boles ot shecified postin

| Counerbuiz: |
? Coumterbares at Specifisd Fusition
! Conntibires o Spechied Foiion

||||||% ;—}'\;:’-;—' punt i Bl 7t Trym |
When you select a product on the 3D screen |: -
’ 1= il i * i 1 it
List of alterations screen will be opened. HeI|_c0|I insert can _be sel_ected The direction and position of hole
W Cick’Edit” button, and then dlick "Add” on the e - by tick box "Insert insertion" can be changed.
neXt screen. Please select the altemstion
ﬁ ) (4) Reflect alteration processing
. Tappirg Pitin  Ackd 125 0N racket for cover mounong.
Check alteration settings and if there is
Brackets require additional C-holes no problems, [ hmcive et
can be inserted click "Finish" button on screen to e S
complete the insertion. - Sy
-
; . Ak irversion | Change
T B : ot | *Additional manual alteration setting will be highlighted in gray as shown in part number.
Multiple selection of parts is possible 25

while press Shift key and select products. © 2022 MISUMI Corporation, All Rights Reserved.



[Advanced operation]

9: Measurement and strength calculation functions

You can check length of all Aluminum frames
In Fra mes, designed at once. it
Measure frame length and strength [How to check] a
. Select "Change view" from camera control .
are available to check. on the right side of screen. s
Then select "Display dimension" button =

Operating Procedure 4
(1) Measuring function Select the staring point Select the ending pointor ~ When measuring by selecting a surface,
or object (Frame/Part) object (Frame/Part) the selected surface is indicated by X .

In Header menu,
Select "Measure" to activate
the measurement mode.
MisUMi
FRAMES For Thailand g

Fle  Tool  Help

'

.
@ Calculate the total mass ( 2 )
:‘_Jk Insert STL data

bal

Insert simple shape
@ e Click "blue triangle" on the frame Concentrated load and Uniform load are
. ' you would like to calculate displayed for checking
(2) Frame strength calculation

In Header menu, ’

Select "Measure frame strength" to

activate strength calculation mode.

26
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10: Total mass calculation [Advanced operation]

- Hint -.

In Fra meSl If you would like t_o select multiple parts
Total mass of created design structure Citck o drag the mouse to make & selection.

are available to check.

Operating Procedure

(1) Select Calculate Total mass 2) Parts Selection (3) Confirmation of results
In Header menu, Click on part that you would like to Mass of selected part will be displayed on
Select "Calculate the total mass" check "Calculate the total mass" at the bottom left of
screen

FRAMES tor i Click "Finish" button to e>$|t measurement m?de'

Fis L:sastP ¥ B ] i | ane |

P}

:u.:‘a Irzert 3TL data

Insert simple shaps

Insert guide shape

Ay ©

Click on another part,
the total mass will be
updated automatically.

27
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Recommended Frames Environment [Appendix]

Recommended Specs

Windows 10 64bit

05 Windows 11 64bit

CPU Core i5 (2.7GHz, 4-core) or higher
memory 8GB or more

graphics board NVIDIA recommended

Software Configuration

application body A set of execution modules for this system
database SQLite

28
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